
Assignment #1 
 
Create 3 web pages: index, project managements page, and contact page 
 
Tasks: 
1. Acquire web host space with http://www.xl0hosting.com or similar banner-free provider. 
2. Create an index page (index.htm). 
3. Create a project management page (cmp.htm). 
4. Create a contact page (contact_me.htm). 
5. Upload all three pages to your web host (remote site). 
6. Test your uploaded web pages by browsing them. 
7. Email the instructor (using mwh710@yahoo.com) the links (urls) to your site as well as the 
three pieces of information necessary for him to look at your remote site (ftp server address, 
login ID, and password). 
 
Assignment overview: 
• For the first assignment use a plain text editor to author your web pages using basic HTML tags. 
(No visual editor like Dreamweaver allowed). 
• On the Mac, use a program called TextEdit, found in the Applications folder (on a PC you can 
use a program called Notepad). 
• When using TextEdit, remember to set the preferences after you open so that you edit in plain 
text only without any type of formatting. 
• Once you set the preferences in TextEdit, you will need to open a new document. There should 
now be no formatting toolbar showing at the top of this new document. (You are going to be 
create html pages, which are just text.) 
• Create a new folder to save your course files into, I recommend naming folder the first letter of 
first name and your last name GRC 175, for example mine would look like mHarrisonGRC175. 
• When you save your web pages you need to add the .htm file extension, for example cmp.htm, 
contactMe.htm, and index.htm. 
• Once you save your document, you can attempt to view in a web browser by double clicking on 
the file, wherever the file was saved; the default web browser on your computer will open the file. 
• Also, once you have a web page open in a browser, you can view its HTML code by viewing 
the source: e.g. View > Source in IE, View > View Source in Safari. 
• Provide different titles for your three web pages. 
• Follow the specific instructions given in the instructions which follow. 
• Remember, you are not using an HTML authoring program such as Dreamweaver. 
 
Sample webpage tags: 
 
Hyperlink, links to another webpage 
<a href="URL goes here">Type a name for the link</a> 
 
Image 
<img src="image filename location goes here" /> 
 
 



Paragraph, adds 1 line space before and after paragraph 
<p>paragraph content goes here</p> 
 
Line Break, carriage return to next line 
<br /> (self-closing tag) 
 
Table, provides a structure for holding data 
<table> 
<tr> 
<td>cell 1 row 1 content goes here</td> 
</tr> 
<tr> 
<td>cell 1 row 2 content goes here</td> 
</tr> 
</table> 
Table with two rows and 2 cells in each row 
<table> 
<tr> 
<td>cell 1 row 1</td> 
<td>cell 2 row 1</td> 
</tr> 
<tr> 
<td>cell 1 row 2</td> 
<td>cell 2 row 2</td> 
</tr> 
</table> 
 
Bold text 
<strong>bold text goes here</strong> 
 
Italicized text 
<em>italicized text goes here</em> 
 
Headline (Heading) size 1-6, 1 largest 
<h1>heading 1 text goes here</h1> 
 
mailto: hyperlink 
<a href="mailto:john.doe@csn.edu">john.doe@csn.edu</a> 
 
Align=”center” 
<p align="center">paragraph text goes here</p> 
 
Here’s a sample of a simple webpage, most content is within the body 
<html> 
<head> 
<title>Michael’s Homepage</title> 



</head> 
<body> 
Welcome to my first webpage<br /> 
<p>When I grow up I want to be the next webmaster superstar</p> 
Checkout my favorite news site 
<a href="http://www.cnn.com">CNN</a> 
<br /> 
<br /> 
3D HDTV seems to be the biggest electronics buzz this year 
<table> 
<tr> 
<td>Analog TV</td> 
<td>HDTV</td> 
<td>3D HDTV</td> 
</tr> 
<tr> 
<td>Currently Predominant</td> 
<td>TV req'd by Feb 2009</td> 
<td>The true future of TV?</td> 
</tr> 
<tr> 
<td>Out of date, most people already gotten rid of</td> 
<td>Most people own one or more today</td> 
<td>Expensive, funny glasses</td> 
</tr> 
</table> 
<p>Here's a cool image of Steve Jobs 
<img src= http://net.onextrapixel.com/wp-content/uploads/2011/10/01SteveJobs.jpg /> 
<p/> 
</body> 
</html> 
 
Create an index page (index.htm) 
 
NOTE: you may give an .htm or an html extension to your web pages, but the three-letter 
extension is recommended because it is a Unix standard. Keep your naming consistent. All of the 
extensions in these instuctions should be .htm. Many webhosts require you to have an index.htm 
page stored within your web host directory. The index page is the default page to show under 
your host directory or web space. We will start out by creating an index page using a plain text 
editor and authored using the basic required HTML tags. 
 
• On the Mac we will use a program called Text Edit, found under our Applications folder. 
• On a PC you can use a program called Notepad. 
• First, open up Text Edit 
• Within Text Edit click on Text Edit >Preferences (located at top menu) 
• Under the “New Document” tab select the plain text option for new documents 



• Click on the “Open and Save” tab and select the “Ignore rich text commands in HTML files” 
option, and the “Ignore rich text commands in RTF files” option. Then UNCHECK the “Add 
“.txt” extension to plain text files. 
• Close preferences window (red button at top left). 
• Open a new document, a plain text document should open. 
• Plain text means there is no formatting bar at the top of the editor. 
• Once you set the preferences you will need to open a new document. 
• Please note tags in HTML are now case sensitive; always use lowercase. 
• Type the following required HTML tags into the text editor 
 
<html> 
<head> 
<title>Beginning Index Page of “your name”</title>  
</head>   
<body bgcolor="#ef8536">  
<center>  
<h1>Welcome to GRC175B</h1> <h3>I hope that you enjoy the class and learn something at 
the same time. (Make up some of your own content text)</h3>  
<h3><a href="cmp.htm">To my CMP page</a></h3> 
 </center>  
</body>  
</html> 
 
Save it as index.htm 
 
Open another new document and type in this: 
<head> 
<title>Project Management Page—“your name”</title> 
</head> 
<body> 
<p align="center"><strong>Project Management Page—GRC 175</strong></p> 
<p align="center"><strong>”your name”</strong></p> 
<table align="center" width="300" border="1" cellpadding="10" bgcolor="silver"> 
<tr> 
<td><em><strong> Assignments </strong></em></td> 
<td><em><strong> Book work </strong></em></td> 
</tr> 
<tr> 
<td><a href="contactMe.htm">A1 Contact Page</a></td> 
<td>&nbsp;</td> 
</tr> 
<tr> 
<td>&nbsp;</td> 
<td>&nbsp;</td> 
</tr> 
<tr> 



<td>&nbsp;</td> 
<td>&nbsp;</td> 
</tr> 
<tr> 
<td>&nbsp;</td> 
<td>&nbsp;</td> 
</tr> 
<tr> 
<td>&nbsp;</td> 
<td>&nbsp;</td> 
</tr> 
<tr> 
<td>&nbsp;</td> 
<td>&nbsp;</td> 
</tr> 
<tr> 
<td>&nbsp;</td> 
<td>&nbsp;</td> 
</tr> 
<tr> 
<td>&nbsp;</td> 
<td>&nbsp;</td> 
</tr> 
<tr> 
<td>&nbsp;</td> 
<td>&nbsp;</td> 
</tr> 
</table> 
</body> 
</html> 
 
Save as cmp.htm 
 
Open another new document and type in this: 
 
• For the contact page we will be adding some images, several paragraphs, providing contact info, 
and more. 
• Create a new plain text document. 
• Here are the basic required htm tags, type them into TextEdit (Notepad). 
 
<html> 
<head> 
<title> 
a title can go here 
</title> 
</head> 



<body> 
main content of your webpage will go here 
</body> 
</html> 
• Replace title and main content with your info. 
• Next, we will add an image to this page. 
• First, in order to add an image use the img (image) tag, it must go in the body. 
 
img 
<img src="filename or url location" /> 
 
• Replace filename with the local filename of your image (image should be in a folder labeled 
“images” in your root folder) or provide the URL of the image you are linking to (you can link to 
an image on the web using its URL). Image should (usually) end with the .gif, .jpg, or .png file 
extension. Image file paths are either relative or absolute paths. You will need to add 2 images, 
one of each of the file location types, absolute and relative, use your own url don’t use the url in 
my example. 
 
Absolute filename example: 
<img src="http://oz.irtc.org/ftp/pub/stills/1996-08-31/beach.jpg" /> 
 
Relative filename example: (example below reads, look inside an images folder 
for beach.jpg) 
<img src="images/beach.jpg" /> 
 
• You need to have one image with a relative file location which means the image and the folder 
it is in will have to be uploaded to your web space. 
• For the relative image put a copy of the image inside the folder labeled “images”, which should 
be inside your root classroom folder. 
• You need to have another image with an absolute file location which means the image will 
already be on the web somewhere, you will need to know its complete URL. 
• Next add a border to each of these images: 
 
img with border 
<img src="imagename.jpg" border= "1" width="200" height="150" /> 
 
• Save and preview in a web browser. 
 
• Add a background image to this web page by adding a background property to our body tag.  
 
Body with background 
<body background="http://www.nutrocker.co.uk/images/tiles/gold_noise.jpg" /> 
 
Note: We will learn in the next assignment how to use stylesheets to style our 
webpage. Stylesheets are the preferred method for adding a background to a 
webpage vs using HTML in the above example. 



 
• Next, add a new paragraph and type several sentences inside of this paragraph. Add at least two 
examples of a line break within this paragraph. <br /> A line break is a carriage return, there is 
no extra spacing between lines like there is with paragraphs. Simply put the line break tag where 
you want the line break to occur <br /> 
 
Example of a paragraph with two line breaks: 
<p>if you take the color juxtapositions and their proportions from nature, you won't 
go far wrong. 
<br />The golden browns, bright and pastel greens of an onion are conservatively safe but the 
magenta, vermilion and greens of a dragon fruit are positively psychedelic. 
<br /> In nature, some colors are there to attract insects and assist procreation and others are 
there to camouflage, and dissuade predators.</p> 
 
• Next, add a horizontal rule somewhere on your page. A horizontal rule is a bar that appears 
horizontally across the page. 
 
hr horizontal rule 
<hr /> 
 
• Modify to have a custom size similar to example 
<hr size="3"/> 
 
• Next, add an ordered list with three list items of your three favorite things to do or three 
favorite movies. 
 
ol, ordered list, each list item is numbered 1, 2, 3, etc. 
<ol> 
<li>1st list item text goes here</li> 
<li>2nd list item text goes here</li> 
<li>3rd list item text goes here</li> 
</ol> 
 
Note: Alternatively we could create an unordered list, each item would be 
bulleted instead of being numbered 
<ul> 
<li>car</li> 
<li>boat</li> 
<li>train</li> 
</ul> 
• Recommended: Add a paragraph before the list and explain what the list represents, spacing 
will be added between paragraph and list. 
 
<p>These are my three favorite movies</p> 
<ol> 
<li>A River Runs Through It</li> 



<li>The Orphanage</li> 
<li>Rocky Horror Picture Show</li> 
</ol> 
 
• Next, somewhere on the page add a link to your favorite website using the HREF tag. Use your 
own URL. 
 
href hyperlink 
<a href="http://www.imdb.com">Internet movie database</a> 
 
• Try adding the a short sentence before the hyperlink, notice I added a line break after the 
sentence 
Here’s my favorite website: <br /> 
 
• Again, the difference between a <p></p> tag and <br /> is that a <p> paragraph tag will put a 
blank line after the paragraph is closed. A <br /> is used where you want a simple line break or 
carriage return, there will be no extra line spacing, also notice a <p> tag has an opening and 
closing tag but a <br /> only has one tag, you put it where you want line break to occur.  
• Next, add a mail to: hyperlink at the very bottom of your page that provides a way 
of contacting you by email. 
 
mailto: href hyperlink 
<a href="mailto:email@emailaddress.com">text for hyperlink</a> 
 
• I recommend putting inside a <p></p> tag in order to provide spacing around the 
link. 
<p> 
<a href="mailto:ajones@gmail.com">contact the webmaster</a> 
</p> 
 
• Next, add some examples of bold, italic text anywhere on the page. 
 
Bold text 
<strong>bold text goes here</strong> 
 
Italicized text 
<em>italicized text goes here</em> 
 
• Save and preview in a web browser 
• Example of my finished contact page. Your page will obviously look different than mine: 
 
<html> 
<head> 
<title>Mr. Harrison's contact page</title> 
<body background="http://www.nutrocker.co.uk/images/tiles/gold_noise.jpg"> 
</head> 



<body class="center"> 
<center> 
<p>Well another semester is beginning.<br /> 
  I know it may be difficult in the beginning, but it gets easier.<br /> 
  Stay with me, trust me and ask questions.<br /> 
  Oh, yeah - have a good time. 
</p> 
<p>&nbsp;</p> 
<p><img src="images/fPit.jpg" alt="open air fire pit" border="3" /> 
</p> 
<p> <img src="http://oz.irtc.org/ftp/pub/stills/1996-08-31/sunset.jpg" alt="sunset" width="320" 
height="182"  border="3" /></p> 
<p><strong>It is fascinating that words can make web pages interactive</strong><br /> 
In this class we will learn many different codes that manipulate the page in many ways.<br /> 
  <em>If I knew yesterday what I know today, I would be a wealthy man</em></p> 
<hr /> 
<p>My 3 favorite things to do:</p> 
<ol> 
  <li>Sitting around a camp fire</li> 
  <li>Spending time with my wife</li> 
  <li>Spending quality time with my daughter</li> 
</ol> 
<p>My favorite site is:&nbsp;<a href="http://mwharrison.com">Here</a></p> 
If you further questions feel free to contact me at: 
<p><a href="mailto:mwh710@yahoo.com">mwh710@yahoo.com</a></p> 
</body> 
</html> 
 
FTP it up to your x10 account 
Check it out on the web using a couple of browsers 
 
Send an email to instructor 
• Send instructor an email via Yahoo mail with your url links to your site. 
• In the email, you must put your full name in the subject line. 
• Remember to send me the 3 url’s for your 3 webpages: 
 
http://mwHarrison.x10.mx/cmp.htm 
http://mwHarrison.x10.mx/contactMe.htm 
http://mwHarrison.x10.mx/index.htm 
 
 
 
 
 
 
 



Grading Criteria: 
� 3 pages, hand coded, saved as index.htm, cmp.htm and contactMe.htm 
� Provided different titles for your three main web pages 
� Published pages to the web 
� emailed instructor with 3 links 
 
For index.htm: 
� Created a basic web page with some sort of content and unique title 
 
For cmp.htm: 
� Created a table with 2 columns and at least twelve rows for the class management page, 
cmp.html 
� Table provides a link from A1 Contact Page to contactMe.htm 
� Added additional table attributes to your table; align, width, cellpadding, bgcolor and border 
� Examples of centered, bold, and italicized text  
 
For contactMe.htm: 
� Had a paragraph which provides two examples of the different line breaks within it 
� Included examples of centered, bold, italic 
� Included two images with borders on your contact page, one image provides an example of a 
relative link and one provides an example of absolute link 
� Added a horizontal rule somewhere on your page 
� Added an ordered list with three list items 
� Provided a hyperlink to another website 
� Provided an email hyperlink 
 
Terms you should now be familiar with: 
URL 
Common web file formats 
.jpg 
.gif 
.png 
.html 
Min required HTML tags 
Relative vs absolute paths 
FTP 
Web hosting 
Host/Hostname/FTP 
Username and password (host) 
Domain name 
Text editor 
index page 
web directory 
<html> 
<head> 
<title> 



</title> 
</head> 
<body> 
</body> 
</html> 
<a href="URL goes here">Type a name for the link</a> 
<img src="image filename location goes here" /> 
<p>paragraph content goes here</p> 
<br /> 
<table> 
<tr> 
<td>cell 1 row 1 content goes here</td> 
</tr> 
<tr> 
<td>cell 1 row 2 content goes here</td> 
</tr> 
</table> 


